Halliburton acknowledges that certain third party code has been bundled with, or embedded in, its software. The licensors of this third party code, and the terms and conditions of their respective licenses, may be found at the following location:

[Installdir]\webapps\openwire\ReleaseNotes\Third_Party.pdf
Contents

Welcome to OpenWire Client Software ........................................... 1
Overview of System Architecture .................................................. 2
System Requirements ................................................................. 3
  Platform Requirements ......................................................... 4
  Software Requirements ......................................................... 6
Supported WITSML Providers ..................................................... 8
OpenWire Client Documentation .................................................. 9
Licensing .................................................................................. 10
  License Verification in Pipeline Wizard .................................... 12
  LAM 5000 ............................................................................. 13
Overview .................................................................................. 17
Installation Steps Overview ....................................................... 18
Planning the Installation ............................................................. 19
Installing OpenWire Client Software ............................................. 20
  Prerequisites ......................................................................... 20
  Migrating OpenWire Client Software Configuration Settings ....... 22
Uninstalling Previous Versions of OpenWire Client Software .......... 33
Installing OpenWire Client Software and Related Programs .......... 37
Checking the Installation ............................................................. 63
Repairing the Installation ............................................................ 66
Post-Installation Instructions ....................................................... 68
  Changing the Administrator Password and Setting the Administrator Email Address  . 69
  Setting up the SMTP Server ..................................................... 70
  Setting up the Proxy Server ...................................................... 71
  Setting up EDM for the SAM to Work in a Network Environment ...... 73
  Configure the OpenWorks Database to Create Position Logs .......... 74
Configuring OpenSpirit/Geoframe Installations ........................................ 75
Requesting a Login ID ............................................................................. 76
Setting up the Simulator .......................................................................... 78
Changing Microsoft Internet Explorer Setting for OpenWire Client Software on Windows XP, SP 2 and SP3 ...................................................... 80
Troubleshooting ....................................................................................... 81
Installing OpenWire Client Configuration Database in a non-EDM SQL Server 2005 Express and SQL Server 2008 Express Instance ........................................ 82
Services Do Not Start ................................................................................ 86
Services Do Not Install ............................................................................. 88
Problems With Interrupting the Installation .............................................. 91
The Apache Tomcat Server Has a Port Conflict ...................................... 93
Receiving an Error Message After Login .................................................. 94
Invalid Windows Security Certificates .................................................... 95
Welcome to OpenWire Client Software

This chapter introduces you to the System Requirements and Architecture for OpenWire Client software and it’s associated third-party products. In this release the OpenWire Client software continues to support and strengthen the web-based client/server application introduced with previous releases.

The following items are discussed in this section.

• Overview of System Architecture (page 2)
• System Requirements (page 4)
• Supported WITSML Providers (page 8)
• OpenWire Client Documentation (page 9)
• Licensing (page 10)
Overview of System Architecture

The OpenWire Client software is a Java-based application that uses common Java technology to connect components. OpenWire software also uses two databases: one for configuration information and the other for engineering data received from remote sites.

The following diagram shows the general architecture of the OpenWire Client software.

![Diagram of OpenWire Client Architecture](image)

Major Components of OpenWire Client

- **OpenWire Client software**: The OpenWire Client software includes a browser-based user interface and the application logic for receiving, transforming and sending data between drilling platforms and databases.

- **Java JDK**: OpenWire Client is a Java application that based on the Java SE platform. OpenWire Client is supported for Windows platforms that are running a recent release of the Java Development Kit (JDK).

- **Apache® Tomcat Server**: Apache Tomcat allows multiple users to access OpenWire Client software. This application is included in the OpenWire Client software installation.

- **Configuration Database**: OpenWire Client software must have a database to store user settings, proxy settings, and pipeline information. This database—called a “configuration database”—
can exist on Microsoft SQL Server 2005, SQL Server Express 2005, or Oracle 10g, depending on your configuration. The OpenWire Client software configuration database is created during the installation, and therefore the install will need a database user account with create privileges to complete the installation procedure.

- **Engineering Database Database**: Drilling data from remote rigs is streamed into the OpenWire Client software in WITSML format. It is then stored in a relational database designed for engineering data. The databases supported by OpenWire Client software are Engineer’s Data Model (EDM), OpenWorks, and GeoFrame.
System Requirements

The Windows machine on which OpenWire Client is installed must meet certain minimum requirements. It must have adequate hardware resources and supported versions of the following resources:

- operating system
- web browser
- Java infrastructure
- engineering database
- configuration database

Hardware Requirements

OpenWire Client software requires the following minimum available hardware resources:

- **CPU**: 3 GHz or faster
- **RAM**: 4 GB or more
- **Disk Space**: 2 GB or more

Supported Operating Systems

OpenWire Client software version 5000.1.4 can be installed on the following operating systems:

- Windows 7, 64-bit
- Windows® XP Professional, x32, Service Pack 3¹
- Windows® XP Professional, x64, Service Pack 3²
- Windows® 2003 Server, x32, Service Pack 2³
- Windows® 2003 Server, x64, Service Pack 2³
- Windows® 2008 Server, x32, Service Pack 2⁴
- Windows® 2008 Server, x64, Service Pack 1
- Windows® Vista, x32, Service Pack 1
- Windows® Vista, x64, Service Pack 1

Web Browser Requirements

OpenWire Client software uses a browser-based interface. It supports the following browsers:

- Microsoft® Internet Explorer versions 6.0, 7.0, or 8.0

¹. And all previous service pack versions.
**Supported Java Infrastructure**

OpenWire Client software version 5000.1.4 requires:

- Java Developers Kit (JDK) 1.6.0_19
- Apache Tomcat Server 6.0.26

**Supported Engineering Databases**

OpenWire Client software version 5000.1.4 supports connections to the following engineering databases. These databases are not part of the OpenWire installation: they must be obtained and installed separately. The engineering database can be running on a different computer from the computer on which OpenWire is installed.

- Engineer’s Desktop 5000.1.8, 5000.1.7, 5000.1.6, 5000.1.5, 5000.1.4, 5000.1.3, 5000.1.2, 5000.1.1, 5000.1.0, 2003.22.x, 2003.21.x, and 2003.16.1.x. For more information about the platforms supported by each version of EDT, see the applicable version’s *Engineer’s Desktop Drilling Summary Level Release Notes*.
- OpenWorks version 5000.0.2.5. For more information about the platforms supported by OpenWorks, see *OpenWorks Software Version 5000.0.2.5 Release Notes*.
- GeoFrame version 4.3 via an OpenSpirit Satellite 3.1.2 (SP1) connection. For more information about the platforms supported by GeoFrame 4.3, contact Schlumberger. For information about OpenSpirit Satellite, see www.openspirit.com.

**Supported Databases for OpenWire Configuration Database**

Supported database systems for OpenWire Client software’s configuration database:

- Oracle® 9i, 32-bit (Oracle ODBC Driver version 9.02.00.65)
- Oracle® 10g (10.2.0.3 Server, 32-bit)
- Oracle® 10g (10.2.0.4 Client, 64-bit)
- Windows® SQL Server 2005, 32- and 64-bit
- Windows® SQL Server 2008, 32- and 64-bit
- Windows® SQL Server Express 2005, SP3, 32- and 64-bit

---

1. OpenWire Client software ships with SQL Server 2005 Express Edition, 32-bit. The installation will detect if no database exists and provide an option to install a SQL 2005 Express instance on either a 32-bit or 64-bit machine where you can store OpenWire Client software’s configuration database. The SQL Server 2005 Express Edition that ships with OpenWire Client software is 32-bit, but will work on a 64-bit platform under Windows on Windows (WOW64) emulation.
Supporting Components

OpenWire Client software requires the following additional software:

- Landmark LAM 5000: OpenWire Client software uses the LAM 5000 license manager together with a valid license file. The LAM 5000 software is available on the Halliburton-Landmark web site.
- Microsoft .NET Framework 2.0 (SP2). If the framework is not already installed, the OpenWire Client installer will give you the option to install it.
- Adobe Acrobat Reader: OpenWire Client release notes, patch readme documents and this installation guide are distributed as Adobe PDF documents. Download the Adobe Acrobat Reader at: http://get.adobe.com/reader/
**Example OpenWire Client Software Deployment**

The following diagram shows some common EDM platform configuration deployment scenarios for OpenWire Client software.
Supported WITSML Providers

The following is a list of WITSML Providers that OpenWire Client software version 5000.1.4 was tested against. All tests were performed against WITSML version 1.2.0 and 1.3.1 objects.

- Halliburton’s INSITE® Data Management Service versions 1.2.e and 2.1.2
- IDS version 20090204
- Kongsberg
- Schlumberger InterAct version 6.1
OpenWire Client Documentation

Documentation for OpenWire Client software consists of:

- Online Help - Delivered as HTML files accessible from the application.

- Installation Guide - The Installation Guide is located on the Landmark Software Management web site. The OpenWireInstallationGuide.pdf file is installed in the <OpenWire Install directory>\OpenWire-5000.1.4.0\InstallationGuide directory when you install the program.

- Release Notes - Release Notes are located on the Landmark Software Management web site and are available through the OpenWire Client software main screen. The OpenWireReleaseNotes.pdf file is installed in the <OpenWire Install directory>\OpenWire-5000.1.4.0\webapps\openwire\Release Notes directory when you install the program.

Adobe® Acrobat Reader is required to read the Installation Guide and Release Notes and can be downloaded from http://get.adobe.com/reader/.
Licensing

OpenWire Client Software 5000.1.4 supports the use of Flexera™ Software's FLEXnet® Publisher licensing.

The licensing method used by OpenWire Client software allows you to purchase your license depending on whether you will be running Geological and Geophysical or Engineering workflows. You will be able to purchase:

- an OpenWire Client software license which allows you to run the OpenWire Client software
- a workflow specific license that will connect to only one of the destination databases (EDM or OpenWorks or GeoFrame) based on the desired functionality and database type(s) you are supporting

With any type of licenses, you will receive at least one OPENWIRE_SERVER license and can purchase packages of one or five Pipeline licenses. The OPENWIRE_SERVER license allows you to use OpenWire for performing administrative tasks, pipeline creation and pipeline maintenance. The Pipeline Licenses are used to move data from the WITSML server to the destination database. As long as the pipeline is active (the pipeline is moving data or is waiting to move data) a pipeline license is checked out. The pipeline license will be checked in when the pipeline is stopped.

For additional troubleshooting information, see "Receiving an Error Message After Login" on page 94.

Since the OpenWire Client software connects to several different databases, the full licensing requirements depend on the type of database connection. The minimum licensing requirements for each database are shown below.

Packages

OpenWire is available in various packages (such as OpenWire for Drilling). These packages have different options available with varying combinations of license types.
OpenWorks Database

- Two OpenWorks database licenses
- One “OPENWIRE_SERVER” license
- One or more “OPENWIRE_OW” pipeline licenses

Engineer’s Data Model (EDM) Database

- One EDM database license
- One “OPENWIRE_SERVER” license
- One or more “OPENWIRE_EDM” pipeline licenses

GeoFrame Database

- One OpenSpirit server runtime license
- One OpenSpirit Well model license
- One ‘Landmark OpenWire’ feature license from OpenSpirit
- One “OPENWIRE_SERVER” license
- One or more “OPENWIRE_OPENSPIRIT” pipeline licenses

LAM 5000

Landmark’s Application Manager (LAM) is the license system used to control access to Landmark applications. A new LAM version is required for the OpenWire Client software 5000.x releases. You cannot have both Release 2003.x and Release 5000.x license files running on the same server.

**IMPORTANT! If you have a 2003 version of LAM server, YOU MUST UNINSTALL IT before installing the LAM 5000.0.0 server.**

Failure to uninstall all previous versions of LAM Server before installing LAM Server 5000.0.0 will result in a duplicate FLEXnet Publisher service that replicates itself until it crashes Windows.

The procedures for uninstalling LAM server are detailed in the section “LAM Server Uninstall” in the LAM Guide—Linux, Solaris, and Windows (LAM.pdf).
FLEXnet Publisher licensing is available for networked application and standalone application use. FLEXnet Publisher standalone licensing may be used in conjunction with a network card or through a FLEXnet Publisher dongle (bitlock) where no PC network identification is possible.

Netsecure, Sentinel bitlocks and Crypkey have been discontinued by Landmark and are not supported by Release 5000.x products.

LAM 5000.0.0 for Windows now includes a function called “Borrow”, which is not supported by OpenWire Client Software 5000.1.4.

You must obtain new licenses for OpenWire Client Software 5000.1.4.

To re-license, customers must contact their local Landmark representative. Refer to the LAM Guide—Linux, Solaris, and Windows (LAM.pdf) for details.

**IMPORTANT! If you are using a FLEXnet Publisher 5000.0.0 dongle (bitlock), you must install 5000.0.0 LAM (FLEXnet Publisher 11.4) on the standalone/client machine.**

To install FLEXnet Publisher 11.4 for USB bitlocks:

1. Go to your installed \LAM\FLEXID folder, and run FLEXidInstaller.exe to install the bitlock drivers.
2. In the Welcome to the InstallShield Wizard for Macrovision FLEXid Drivers screen, click Next.
3. In the Select Features screen, select FLEXid 9 and click Next.
4. In the Ready to Install the Program screen, click Install.
5. In the InstallShield Wizard Complete screen, click Yes to restart your computer, then click Finish.
6. To request a bitlock license, run Start > Programs > LAM 5000.0.0 >lmtools. Select System Settings tab; provide the value you see in the FLEXID field.
Basics of Installing a License File

You can install LAM on either a client machine, or install LAM as a license server. Refer to the LAM Guide—Linux, Solaris, and Windows (LAM.pdf) for complete details, but the basics are outlined below. In many cases, it is desirable to install the Engineer’s Desktop on the same machine where OpenWire Client software will reside. The following examples are based on installation of the LAM Client and LAM Server during the Engineer’s Desktop installation.

**LAM Client**

1. When you are installing Engineer’s Desktop, select **Utility** (client) when prompted for the type of LAM install. Continue installing Engineer’s Desktop. The install embeds the client executables for LAM on the machine.

2. Obtain a license file from Landmark. By default the license should be named *License.dat*.

3. Place the license in a directory pointed to by the environment variable LM_LICENSE_FILE.

4. Test the operation of the client by starting one of the Drilling applications. If a license checkout error occurs, run *lmdiag* to help diagnose the problem.

   LAM Client is now set up.

**LAM Server**

1. When you are installing Engineer’s Desktop, select **Server** when prompted for the type of LAM install. Continue installing Engineer’s Desktop. The install embeds the server executables for LAM on the machine.

2. Obtain a license file from Landmark. By default the license should be named *License.dat*.

3. Place the license in a directory pointed to by the environment variable LM_LICENSE_FILE.

4. Test the operation of the client by starting one of the Drilling applications on a client machine. If a license checkout error occurs, run *lmdiag* to help diagnose the problem.

   LAM Server is now set up.
Installation Instructions

Overview

This chapter walks you through the installation of OpenWire Client software and its related third-party products. The installation is followed by post-installation instructions.

The main sections of this chapter are:

• Installation Steps Overview (page 16)

• Migrating OpenWire Client Software Configuration Settings (page 20)

• Uninstalling Previous Versions of OpenWire Client Software (page 31)

• Installing OpenWire Client Software and Related Programs (page 35)

• Post-installation Instructions (page 67)

• Troubleshooting (page 81)
Installation Steps Overview

The major steps for the server installation are shown below along with a documentation reference for each step.

- If you create pipelines to an OpenWorks database, install OpenWorks client on the OpenWire Client software
  
  Refer to the OpenWorks Installation Guide

- If you create pipelines to an EDM database, install an EDM database on the OpenWire Client software, or create an EDM database connection
  
  Refer to the EDM Installation Guide

- If you create pipelines to a GeoFrame database, install OpenSpirit Satellite on the OpenWire Client software
  
  Refer to the OpenSpirit Installation Instructions

- Load LAM and OpenWire Client software license files (EDM and OpenWorks licenses too, if applicable)
  
  Refer to the Landmark LAM documentation

- Migrate configuration settings and uninstall the current OpenWire Client software installation (if applicable)
  
  Refer to page 20 of this manual

- If you will load owrConfigDB into Oracle, obtain an account with sufficient rights.
  
  Refer to page 25 of this manual

- Install OpenWire Client software
  
  Refer to page 35 of this manual

- Follow the Post-Installation instructions
  
  Refer to page 67 of this manual
Planning the Installation

Step 1: What database platform will you use?

See “Prerequisites” on page 18.

Step 2: Do you need to migrate configuration data from an existing installation?

See “Migrating OpenWire Client Software Configuration Settings” on page 20.

Step 3: Is a previous version of OpenWire Client installed?

See “Uninstalling Previous Versions of OpenWire Client Software” on page 31.

Step 4: Are you ready to install OpenWire Client Software?

See “Installing OpenWire Client Software and Related Programs” on page 35.

Step 5: Where will you store the OpenWire Client configuration database?


See “Installing OpenWire Client Software Configuration Database on Oracle” on page 55.

Step 6: Will you create new, upgrade, or replace the configuration database?

Oracle
- No existing, step 25a on page 59
- Keep existing, step 25e on page 61
- Replace existing, step 25f on page 61

See step 25b on page 60
See step 25c on page 60
See step 25d on page 60

SQL
- No existing, step 17a on page 49
- Keep existing, step 17d on page 52
- Replace existing, step 17e on page 53

See step 17a on page 49
See step 17a on page 49
See step 17a on page 49

Create new
Upgrade existing
Replace existing
Installing OpenWire Client Software

This section contains the instructions for installing the applications included with the OpenWire Client machine installation.

Prerequisites

Depending on which database will store OpenWire Client machine configuration data, review the following list to determine which programs must be installed on the OpenWire Client software prior to installing OpenWire Client machine.

- Microsoft .NET Framework. If the appropriate framework version and patch level is not already installed, the OpenWire Client application installation will give you the option to install it.

- OpenWorks client - if you are storing data to an OpenWorks database, the OpenWorks client must be installed on the OpenWire Client software. Please make sure that the `tnsnames.ora` on the OpenWire Client software has the correct information for the OpenWorks server. You can also load an OpenWorks server on the OpenWire Client software.

- EDM - if loading EDM and OpenWire Client machine on the same server, it is recommended that EDM software is loaded before the OpenWire Client machine.

- OpenSpirit Satellite - in order to run a pipeline to a GeoFrame database, the OpenSpirit Satellite must be installed on the OpenWire Client software.

IMPORTANT! Before installing OpenWire Client, you must verify OpenSpirit Satellite is installed, and then apply the “v3.1.2 SP1 - GeoFrame Data Connector patch”. The service pack can be obtained on the OpenSpirit web site.
The following prerequisites MUST be met before OpenWire Client machine users can add a GeoFrame connection:

- A GeoFrame database must exist and be network accessible to the OpenWire Client software.
- Landmark recommends installing the GeoFrame database on a Linux platform.
- OpenSpirit Master 3.1.2 (SP1) must be installed on the same machine as the GeoFrame database. OpenWire Client software supports only connections to a GeoFrame 4.3 database.
- OpenSpirit Satellite 3.1.2 (SP1) must be installed on the same machine as OpenWire Client machine.
- You must install OpenSpirit Satellite with an account that has Administrator rights to the machine, but DO NOT use the local machine “Administrator” account.

- LAM 5000.0.0 - To prevent unnecessary errors at initial start up, we suggest that you load LAM and the OpenWire Client machine license before you install the OpenWire Client application. This will allow OpenWire Client machine to automatically start services for you.
Migrating OpenWire Client Software Configuration Settings

The Migration Utility is used to move configuration settings from previous OpenWire Client software versions into formats compatible with this version. There are no licensing requirements for the utility, only for the OpenWire Client machine system itself.

**IMPORTANT! If your existing OpenWire Client machine configuration settings are in MSDE or SQL Server database, save them with the Migration Utility before you install OpenWire Client machine version 5000.1.4.**

The OpenWire Client machine 5000.1.4 installation is able to migrate ONLY configuration settings saved to the following databases during the installation process:

- Oracle - 2003.0.8, and newer
- SQL Express - 5000.0.0, and newer

If your existing OpenWire Client configuration settings are stored in MSDE or SQL Server databases, perform the migration process described below to save the settings, and skip the migration process in the installation. After the 5000.1.4 installation is complete, import the settings.

The Migration Utility is also useful for copying existing 5000.1.4 database configuration settings as a backup, which can be imported later. For example, running the most current release of the OpenWire Client software database through the Migration Utility will create a copy of the OpenWire Client software configuration database settings.

The Migration Utility exports configuration information from either Registry entries or a configuration database. This exported information is stored in a local file, which can then be imported through the Migration Utility into an OpenWire Client machine configuration database running against the current version on the OpenWire Client software.

The types of information exported or imported are:

- **Provider Connections**—configuration information needed to create a connection to a WITSML server, including the connection URL and username/passwords.

- **Database Connections**—configuration information that defines a destination database of any of the supported database types (EDM, OpenWorks, GeoFrame).
• Mnemonic Translations—configuration information that defines the mnemonic translation between a provider's WITSML’s services and a destination's mnemonic values.

• Unit Translations—configuration information used to define how units are translated from what the WITSML server provides, into the units supported by the destination database.

• Pipelines—configuration information (e.g. mappings) of all existing pipelines in the database.

When the migration utility runs, any one of the above types of information can be selected to extract into a file. If you wish to have more than one type of information, run the Migration utility multiple times.
Migration Utility Installation Package

The installation package “migration.zip” is located in the `<CD root>\OpenWire-<version number>\Migration` directory and in the `\Migration` sub-directory of the OpenWire Client software installation directory. There are no licensing requirements for the utility, only for the OpenWire Client software itself.

Supported export of registry elements are:

- Provider connections (WITSML Servers)
- Database connections (destination projects)
- Mnemonic Translation Lists
- Unit Translations
- Pipelines (for version 2003.0.6 and later)

1. Double-click on `migration.zip` and unzip the files to a temporary directory on the drive where the OpenWire Client software is installed.

2. From the temporary directory where the files were placed, navigate to `\migration\bin` and double-click on `migration.bat`.

The “Migration Utility for OpenWire Configuration” wizard displays a “Welcome to the OpenWire Configuration Migration Utility” screen.

3. Click Next.

The “Import or Export OpenWire Settings” screen displays.
4. Select one of the following options then perform the applicable referenced section of the procedure:

a. **Export OpenWire 2003.0.4 and 2003.0.5 Settings** - select this option to export existing OpenWire 2003.0.4 and 2003.0.5 configuration database settings to a file on the local machine, and then click **Next** and perform “Export OpenWire 2003.0.4 and 2003.0.5 Settings” on page 23.

b. **Export OpenWire 2003.0.6, 2003.0.7, 2003.0.8, 5000.0.0 5000.1.0, 5000.1.1, 5000.1.2, 5000.1.3 and 5000.1.4 Settings** - select this option to export configuration database settings from previous OpenWire Client software versions to a file on the local machine, and then click **Next** and perform “Export OpenWire 2003.0.6, 2003.0.7, 2003.0.8, 5000.0.0, 5000.1.0, 5000.1.1, 5000.1.2, 5000.1.3 and 5000.1.4 Settings” on page 24.

c. **Import OpenWire Settings to an OpenWire 5000.1.4 installation** - select this option to import OpenWire Client software configuration database settings from a file to an OpenWire Client Software 5000.1.4 installation that is accessible on the network, and then perform “Import OpenWire Client Software Configuration Database Settings to an OpenWire Client Software 5000.1.4 Installation” on page 27.

**Export OpenWire 2003.0.4 and 2003.0.5 Settings**

a. From the “Select items to be exported” screen, select the options to export. Select multiple entries if needed as follows:

<table>
<thead>
<tr>
<th>Desired operation</th>
<th>Keyboard and Mouse function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a range of options</td>
<td>Select the first option, then hold the <strong>Shift</strong> key and click on the last option to select (highlight) the range of options</td>
</tr>
<tr>
<td>Select specific multiple options</td>
<td>Select the first option, then hold the <strong>Ctrl</strong> key and click on other options until all desired options are selected (highlighted)</td>
</tr>
</tbody>
</table>

b. Click **Next**.

The “Export File Location” screen displays.
c. From the “Export File Location” screen, click on the ellipse button to select a directory to save the export file. Controls on this dialog allow you to quickly navigate to the desktop, create new folders, and select local and network directories.

d. Enter a unique name for the and a file to export the OpenWire Client software configuration database settings.

The “Open” dialog displays.

e. Navigate to the location of the owrConfigDB file to be exported.

f. Click Open to return to the “Export File Location” screen.

g. Click Next to start the export operation.

The database configuration settings are exported, and the “Export Completed” screen displays with a red checkmark next to “Export completed successfully”.

Notes

- Click on the Start Over button to export additional database configuration settings or to import the file that was just created.
- If a red X symbol ( ❌ ) appears with a report of an error, the export failed. Click on the Back button and continue to go back to check all settings then try again. If the migration continues to fail, contact Landmark Support.

Export OpenWire 2003.0.6, 2003.0.7, 2003.0.8, 5000.0.0, 5000.1.0, 5000.1.1, 5000.1.2, 5000.1.3 and 5000.1.4 Settings

a. From the “Select OpenWire instance” screen, select SQL Express or Oracle from the Database Type picklist.

b. Enter the Database Settings.

SQL Server Settings

In most cases the migration utility is run on the local machine where the OpenWire Client software is installed and the defaults can be accepted.
**Machine Name** - enter the name of the OpenWire Client software. By default, the client machine is `localhost`. Normally, the default “localhost” will work. If not, enter the machine name or the machine IP address.

**Instance Name** - enter the name of the SQL Express instance where the OpenWire Client software configuration database is stored. In most cases you will need to enter another name rather than use the default. For SQL Server versions previous to SQL Express, clear the field and leave it blank.

**Database Name** - enter the name of the OpenWire Client software configuration database. The default entry is “owrConfigDBR5000”. Change the version number if needed to migrate previous versions of the database.

**User and Password** - enter the user name and password for the database. The user account must have Administrator rights to the database. The default user name and password is “openwire”.

*Oracle Settings*

**Host** - enter the name of the host server for the Oracle database. If the database resides on local machine, enter `localhost` (alternatively enter the machine name or machine IP address).

**Port** - enter the database port. The default Oracle database port number is `1521`.

**Oracle SID** - enter the System ID. If you do not know it, contact the schema owner.

**User and Password** - enter the user name and password for the database. The user account must have Administrator rights to the database. Migration from an OpenWorks database requires Interpreter privileges.

c. When the database settings are entered, click on the **Test Connection** button.

d. If the connection succeeds, a confirmation displays. Click **OK** to proceed. If the connection fails, verify the information entered on the “Select OpenWire instance” screen is correct and retest the connection.
e. When the database connection is successful, click **Next**.

The “Select items to be exported” screen displays.

f. From the “Select items to be exported” screen, expand the nodes in the tree to select the options to export. Select multiple entries if needed as follows:

<table>
<thead>
<tr>
<th>Desired operation</th>
<th>Keyboard and Mouse function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a range of options</td>
<td>Select the first option, then hold the <strong>Shift</strong> key and click on the last option to select (highlight) the range of options</td>
</tr>
<tr>
<td>Select specific multiple options</td>
<td>Select the first option, then hold the <strong>Ctrl</strong> key and click on other options until all desired options are selected (highlighted)</td>
</tr>
</tbody>
</table>

Supported export of registry elements are:

- Provider connections (WITSML Servers)
- Database connections (destination projects)
- Mnemonic Translations Lists
- Unit Translations
- Pipelines

g. Click **Next**.

The “Export File Location” screen displays.

h. From the “Export File Location” screen, click on the ellipse button to select a directory and a file to export the OpenWire Client software configuration database settings.

The “Select Data File” dialog displays.

i. Navigate to the location where the owrConfigDB file will be exported.

j. Enter a unique **File Name** to name the export file.

k. Click **Open** to return to the “Export File Location” screen.
l. Click **Next** to start the export operation.

   A red checkmark with the statement **Export completed successfully** displays.

<table>
<thead>
<tr>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Click on the <strong>Start Over</strong> button to export additional database configuration settings or to import the file that was just created.</td>
</tr>
<tr>
<td>• If a red X symbol ( ![ ] ) appears with a report of an error, the export failed. Click on the <strong>Back</strong> button and continue to go back to check all settings then try again. If the migration continues to fail, contact Landmark Support.</td>
</tr>
</tbody>
</table>

**Import OpenWire Client Software Configuration Database Settings to an OpenWire Client Software 5000.1.4 Installation**

a. From the “Select the file to be imported” screen, click the ellipse button.

   The “Select Data File” dialog displays.

b. Navigate to and select a OpenWire Client database file to import.

c. Click **Open** to return to the Select the file to be imported screen.

d. Click **Next**.

   The “Select OpenWire instance” screen displays.

e. From the drop-down menu, select the **Database Type**.

f. Enter the Database settings.

   **SQL Server Settings**

   In most cases the migration utility is run on the local machine where OpenWire Client software is installed and the defaults can be accepted.

   **Machine Name** - enter the name of the OpenWire Client software. By default, the client machine is *localhost*. 
**Instance Name** - enter the name of the SQL Express instance where the OpenWire Client software configuration database is stored. In most cases you will need to enter another name rather than use the default. For SQL Server versions previous to SQL Express, clear the field and leave it blank.

**Database Name** - enter the name of the OpenWire Client software configuration database. The default entry is “owrConfigDBR5000”. Change the version number if needed to migrate previous versions of the database.

**User and Password** - enter the user name and password for the database. The user account must have Administrator rights to the database. The default user name and password is “openwire”.

**Oracle Settings**

**Host** - enter the name of the host server for the Oracle database. If the database resides on local machine, enter localhost.

**Port** - enter the database port. The default Oracle database port number is 1521.

**Oracle SID** - enter the System ID. If you do not know it, contact the schema owner.

**User and Password** - enter the user name and password for the database. The user account must have Administrator rights to the database. Migration from an OpenWorks database requires Interpreter privileges.

g. When the database settings are entered, click on the **Test Connection** button.

h. If the connection succeeds, a confirmation displays. Click **OK** to proceed. If the connection fails, verify the information entered on the “Select OpenWire instance” screen is correct and retest the connection.

**Duplication of Settings**

If the settings imported already exist in the database, a dialog displays that requires a decision to ignore, ignore all, or overwrite.
i. When the database connection is successful, click **Next** to start the import operation.

The database configuration settings are imported and a screen displays with a red checkmark next to *Import completed successfully*.

**Note**

Click on the **Start Over** button to import/export additional configuration settings.

You are now ready to uninstall the OpenWire Client machine if it exists on the client machine. If OpenWire Client machine is not installed on the machine, skip to “Installing OpenWire Client Software and Related Programs” on page 35.
Important!

OpenWire Client machine versions 5000.1.4, 5000.1.3, 5000.1.2, 5000.1.1, 5000.1.0, 5000.0.0, 2003.0.8 and 2003.0.7 will compete for the use of the default HTTP port (typically 8080), and can not coexist on the same machine without modifications to the installed version.

Landmark recommends that you remove the previous version of OpenWire Client machine before installing version 5000.1.4, however it is possible to install 5000.1.4 without removing the previous version(s) if you disable the services associated with OpenWire Client machine version 2003.0.7 and 2003.0.8 from automatically running. This allows the 5000.1.4 installation to complete its tasks.

If you must have multiple versions running at the same time, modify the port in the Apache-Tomcat “server.xml” configuration file located in the installation directory (for example, the default directory for OpenWire Client machine version 5000.1.0 is:

\OpenWire-5000.1.4.0\apache-tomcat-6.0.26\conf

In the “server.xml” file, modify the line that starts with:

<Connector port="8080"

and replace the 8080 port with some other accessible port on this machine, then save and restart the services or machine. This modifies the URL used to access OpenWire Client machine.

Alternatively, you can change port numbers by following the procedure found in OpenWire Client Help topic “Changing Apache Tomcat Ports”. This procedure outlines how to use the “Tomcat Port Configuration” dialog run from the TomCatPortConfig.bat file found in the \OpenWire-5000.1.4.0\apache-tomcat-6.0.26\bin directory.

Landmark also recommends that you backup the OpenWire Client machine configuration database settings using the migration utility, which is included on the Landmark Software Manager web site as a zip file. Alternatively, you may choose to backup the OpenWire Client machine configuration database (in either SQL Express or Oracle) prior to the installation process. For details on how to backup the OpenWire Client machine configuration database prior to this installation, contact Landmark Support.
Uninstalling Previous Versions of OpenWire Client Software

After running the migration utility, you will need to uninstall previous versions of OpenWire Client machine if it exists on the OpenWire Client software. If you desire OpenWire Client Software 5000.1.4 software to co-exist with previous versions on the same machine, contact Landmark Support for assistance.

The procedure below assumes OpenWire 2003.0.8 software is installed. There are three steps to the uninstall:

1. Uninstalling OpenWire Client machine (which includes an uninstall of all services and 3rd-party software)
2. Uninstalling MSDE (for pre-2003.0.8.0 OpenWire Client machine installations)
3. Deleting a subdirectory on the OpenWire Client software.

You may want to also uninstall your LAM application, which is optional and not required.

Follow the steps below to completely uninstall OpenWire Client software and its associated third-party programs.

Note
If OpenWire Client machine has never been installed before, skip to the section titled “Installing OpenWire Client Software and Related Programs” on page 35.

Uninstalling Previous Versions of OpenWire Client Software, JDK, and Apache Tomcat Server

1. Shutdown all open applications to prevent interruption to the OpenWire Client software installation.
2. Select Start, Control Panel.
3. Select Add or Remove Programs.
4. Select Landmark OpenWire 2003.0.8.0 then click the Change/Remove button. The version number may differ, depending on what version of OpenWire Client software is installed.
5. A confirmation dialog will display. Click **OK** to continue the uninstall.

6. If you did not stop the Apache Tomcat service and the LGC OpenWire Client service prior to the uninstall process a command window displays informing you that the processes are being stopped.

7. When the uninstall process is completed, a prompt to reboot will display. Click **OK** to reboot.

### Uninstalling OpenWire Client Software Version of MSDE

This section only applies to cases where the existing OpenWire Client machine installation is one previous to version 5000.0.0. Starting with version 5000.0.0, OpenWire Client machine uses SQL Server Express instead of MSDE. If you desire to continue running the previous version of OpenWire Client software, do not perform the following steps in this section.

---

**Changing Port Numbers**

If you run multiple versions of OpenWire Client machine on the same server, verify that different port numbers are used by Apache Tomcat Server. See “The Apache Tomcat Server Has a Port Conflict” on page 94 for details on how to change the port number for Apache Tomcat Server.

---

Previous to version 2003.0.8, OpenWire Client machine was installed with a separate instance of MSDE on your computer. In version 2003.0.8, the OpenWire Client machine installation created a configuration database inside of an MSDE instance. Likewise, version 5000.0.0 and subsequent versions of OpenWire Client machine, creates the OpenWire Client machine configuration database inside a SQL Express Database.

Use the following steps to delete the pre-2003.0.8 OpenWire Client machine version of MSDE.

1. Select **Start > Control Panel**.

2. Select **Add or Remove Programs**.

3. Select **Microsoft SQL Server Desktop Engine** installed for OpenWire Client software (or selected to store the OpenWire...
Client machine configuration database at time of installation) then click the **Remove** button. The Wizard will start.

**Note**

There may be more than one version of MSDE on your OpenWire Client software. Remove only the MSDE database used by OpenWire Client software.

4. A confirmation screen displays. To continue the uninstall, click the **Yes** button to return to the Add or Remove Programs screen.

5. **Close** the Add or Remove Programs screen.

6. If uninstalling and reinstalling OpenWire Client machine versions 2003.0.8, 5000.0.0, or 5000.1.0 along side a previous version of OpenWire Client software, you must delete the SQL Server master database and transaction files:

   a. When reinstalling OpenWire Client software versions 5000.0.0 or 5000.1.0, delete **owrConfigDBR5000.mdf** and **owrConfigDBR5000_log.LDF** from the following location:

      • \Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data

   b. When reinstalling OpenWire Client software version 2003.0.8, delete **owrConfigDB2003.0.8.mdf** and **owrConfigDB2003.0.8.ldf** before reinstalling OpenWire Client software version 2003.0.8 from the following locations:

      • \Program Files\Microsoft SQL Server\MSSQL\Data

      • \Program Files\Common Files\MSDE2000A\MSSQL\Data
Finishing the Uninstall Process

To finish the uninstall of OpenWire Client machine and related programs, a subdirectory on the server must be removed.

Important!

Failure to remove this subdirectory may result in errors during the OpenWire Client machine installation.

1. Launch Windows Explorer.

2. Navigate to the `<OpenWire Install directory>\OpenWire-2003.0.8.0` subdirectory. Your OpenWire Client machine subdirectory may be located in a different location on your computer. If the installation location or version is different, adjust the path listed above accordingly.

3. Delete the entire directory.

This completes the uninstall of OpenWire Client machine and its related products.
Installing OpenWire Client Software and Related Programs

This section will walk you through the OpenWire Client machine installation. The installation loads the following programs:

- Landmark’s OpenWire Client software
- Oracle’s Java Development Kit (JDK)
- Apache Tomcat
- Microsoft SQL Server 2005 Express Edition
- Microsoft .NET Framework

The user logged in during installation MUST have the following rights:

- **Administrator** - verify in **Control Panel > User Accounts** that the user logged in while installing the application has rights to the machine

- **Log on as a service** - verify in **Control Panel > Administrative Tools > Local Security Policy > Local Policies > User Rights Assignment > Log on as a service**. Double-click on **Log on as a service** and check if the user logged in while installing the application has an account listed. If not, add the account.

**IMPORTANT!**

If the Administrator and Log on as a service privileges are not established before starting the installation, the OpenWire Client machine installation will fail.

Preparing to Install on Windows 64-bit Platforms

Before OpenWire Client software can be installed on 64-bit Windows platforms, Data Execution Protection (DEP) must be turned off at both the software and hardware level.

To disable DEP:

1. Login as the Administrator.

2. Disable hardware-based DEP in the BIOS (if the machine has hardware-based DEP).
3. Right-click **My Computer**.

4. Select **Properties > Advanced** tab.

5. Under **Performance**, click the **Settings** button. Select **Data Execution Prevention** tab.

6. Select **Turn on DEP for essential Windows programs and services only**.

7. Click **OK**.

8. Disable User Account Control.

9. If the machine uses Software Management Service (SMS), then unplug the network cable during the install because SMS conflicts with EDT installations.

10. Refer to the detailed instructions for a 64-bit install in the Engineer’s Desktop Software Version 5000.1.8.0 Release Notes.

**OpenWire Client Software Installation**

The options available for the type of OpenWire Client machine installation are based on the OpenWire Client machine’s platform (Windows XP, or Windows 2003 Server) and where the OpenWire configuration database will reside. For example, the Oracle installation offers the option to install OpenWire Client software on OpenWorks or
directly to Oracle. For a SQL Express installation, you must have an existing SQL Express instance available to create a new configuration database, or use the existing OpenWire Client software configuration data.

The procedure below includes the steps needed to install the configuration database into either a SQL Express or Oracle instance. Both installation paths share the same steps in the beginning of the procedure (steps 1 through steps 11 shown below).

After completing step 11 below, the procedure branches to cover storing the OpenWire Client machine configuration database to either SQL Express or Oracle. Each installation path is covered as follows:

- “Installing OpenWire Client Software Configuration Database on SQL Server 2005 and SQL Server 2005 Express” on page 45 (steps 12 through 20)
- “Installing OpenWire Client Software Configuration Database on Oracle” on page 55 (steps 21 through 26)

Install OpenWire Client Software on SQL Express or Oracle

OpenWire Client machine installation files and documentation are delivered via an Electronic Delivery System using the Landmark Software Manager tool. The following procedure assumes all OpenWire Client machine installation files are downloaded.

A common question received by Landmark is “Should I install the OpenWire Client machine configuration database in a SQL or Oracle instance?”. The choice you make usually depends on the following requirements:

- SQL Express - the advantage to installing in a SQL Express instance is that you maintain local control, because the SQL Express instance MUST be installed on the machine where you install OpenWire Client machine.

- Oracle - the advantage to installing in an Oracle instance is that you can install it in any network accessible Oracle instance.

The installation instructions for Microsoft Windows 2003 Server and Microsoft Windows XP are slightly different. The following procedure installs OpenWire Client machine on a Windows XP platform.
Additional notes are included below for the Microsoft Windows 2003 Server installation.

**Windows Automatic Updates and Open Programs**

- Shutdown all open applications prior to installing the OpenWire Client application
- Landmark recommends disabling the Windows Automatic Updates feature if it is enabled prior to installing the OpenWire Client application. This reduces the possibility of receiving an error during the installation. After installation, Automatic Updates can be turned back on if needed. See *Microsoft Help* for details on how to disable and enable Windows Automatic Updates.

1. Open the directory where you downloaded the OpenWire Client machine installation files and run `setup.exe`.

A splash screen opens as the program prepares the installation files, and then the Installation Wizard displays. If Microsoft .NET Framework and/or Microsoft SQL Server 2005 Express are not installed, a screen displays with a list of which programs are missing. Click Install to install the programs before proceeding.

If you will NOT install the configuration database in SQL Server database, but intend to install it in an Oracle database, click Cancel to skip the .NET Framework installation.
If you chose to install .NET Framework, a reboot is required after the framework is installed. Click Yes to reboot. After the machine reboots, the following screen displays. Click Next to proceed.

This screen is an agreement for an Oracle license. Please read the following license information carefully.

- Acceptance of the terms and conditions provided during the install process is required for the installation to be completed and the software to be loaded.

- Failure to accept the terms and conditions will require that the installer remove any Oracle drivers currently installed per previous installation of this software.
2. Review the agreement. Click **Print** if a hardcopy is desired to send the license agreement automatically to your default printer as a Rich Text Format (RTF) file.

3. Select the **I accept the terms in the license agreement** option to enable the “Next” button in order to continue with the installation, and then click **Next**.

4. Enter the **User Name** and **Organization**.

5. Select the option to install the application for all users, or only the user identified in the User Name field.

6. Click **Next**.
7. Enter a network qualified **User name** and **Password** for an account with “Log on as a service” rights under Local Security Settings in Windows Control Panel. This account MUST also hold Administrator rights to the machine where OpenWire Client software is installed. This allows OpenWire Client software to automatically start Windows services during the installation.

**Notes**

- Alternatively, existing user account names on the local machine that have Administrator rights can be entered with the either of the following formats:
  - `\user name`. For example, if the user “openwire” exists, and has Administrator rights, enter “\openwire” (no quotes) in the **User name** field on the dialog shown above.
  - Machine Name\User Name
- Slow connection speeds, server response times, and large numbers of users may cause a delay to return results.
- Incorrect credentials entered for the Domain or User name will result in a failure to start LGC OpenWire Client and LGC OpenWire Client Database services after the installation reboots the machine. In order for OpenWire Client software to run, you will need to start the services after installation. For information on how to manually start services, see “Services Do Not Start” on page 86.

8. Optional step - Change the port numbers if needed.

**Changing Port Numbers**

In this screen, you can change the ports used by OpenWire Client machine. This is especially useful when other software applications compete for the same ports, and you wish to avoid conflict.

**HTTP Connector Port** - handles all external communication that is part of the data flow. The default HTTP port for OpenWire Client machine is 8080.

**Command Port** - handles all internal system requests such as server shutdown and restart. The default Command port for OpenWire Client machine is 8005.
To search for a domain or user name, click on the **Browse** button to open a dialog that allows you to search for either a server/domain or user account.

9. When the Domain and User name are entered, click **OK**, then **Next**.
10. The next panel defines where OpenWire Client machine is installed on the OpenWire Client software. The default location is:

\<installation directory>\OpenWire-5000.1.4.0

To check space requirements and available disk space, click on the **Space** button.

To install to a different location, click on the **Change** button to open a dialog and navigate to another location to install the OpenWire Client software. Select the install location with the **Look in** picklist. Click on the ( ⌬ ) button to navigate up one level. If needed, click on the ( ☐ ) button to create a new directory. Once the location is selected, click **OK**.

**Important!**

If you change the installation path, DO NOT enter any spaces in the new path.
11. Click **Next** to proceed to the database configuration section of the install.

**Decision Point**

At this point in the installation, you will perform one of the following steps based on the type of database chosen to install the OpenWire Client configuration database.

- “Installing OpenWire Client Software Configuration Database on SQL Server 2005 and SQL Server 2005 Express” on page 45 (steps 12 through 20)
- “Installing OpenWire Client Software Configuration Database on Oracle” on page 55 (steps 21 through 26)
Installing OpenWire Client Software Configuration Database on SQL Server 2005 and SQL Server 2005 Express

The following procedure assumes installation into a SQL Server instance configured as a Landmark EDM database. If you intend on placing OpenWire Client’s configuration database in a non-EDM SQL Server 2005/2008 or SQL Server 2005/2008 Express instance, see “Installing OpenWire Client Configuration Database in a non-EDM SQL Server 2005 Express and SQL Server 2008 Express Instance” on page 82.

12. If you intend to store the OpenWire Client software configuration database in a SQL Server 2005 or SQL Server 2005 Express instance, select SQL Server 2005, then click Next.

**Important!** If you intend to store the OpenWire Client software configuration database in a Oracle instance, skip to step 21 and proceed with the installation from that point.
13. Click **Install**.

A panel displays that shows the progress of the installation.

**IMPORTANT!** If your existing OpenWire Client machine configuration settings are in MSDE or SQL Server database, save them with the Migration Utility before you install OpenWire Client machine version 5000.1.4.

The OpenWire Client machine 5000.1.4 installation is able to migrate ONLY configuration settings saved to the following databases during the installation process:

- Oracle - 2003.0.8, and newer
- SQL Express - 5000.0.0, and newer

If your existing OpenWire Client configuration settings are stored in MSDE or SQL Server databases, perform the migration process described below to save the settings, and skip the migration process in the installation. After the 5000.1.4 installation is complete, import the settings.
14. Next, the OpenWire Client software installation will install the configuration database settings within an existing SQL Server instance. The OpenWire Client software installation checks for an instance named “SQLEXPRESS”. In most cases, a database named “SQLEXPRESS” will not exist and the screen shown next will display. You will need to change the name to the SQL Express database installed on your system where the OpenWire Client software configuration database will be installed.

15. Click on the Change button to create an OpenWire Client software configuration database in a different SQL Server or SQL Express database than the default. This option is also useful if you desire to run the OpenWire Client software configuration database separate from the default EDM database, or have multiple versions of OpenWire Client software running on the same machine.

Enter the Name of the SQL Server Express instance, then click OK. The name must contain only alpha-numeric characters and no spaces, the user name and password credentials must be correct, and the database must exist. In the example below, an underscore character is used in place of a space.
The default name of an EDM 5000.x database is “EDM5000”. It is also the name of the database if SQL Express 2005 was installed during this installation.

16. The next screen that shows that the database was found. Enter the Password for the database, and then click Next to proceed. The default “sa” password for the SQL Server 2005 Express instance shipped with EDM is “Landmark1”.

**Unknown Password**

If you are unsure of the password, contact the database Administrator (schema owner) to obtain the password. If you are unable to obtain the password, click Cancel. OpenWire Client software will not start the LGC OpenWire Client service after reboot and you will need to uninstall and then reinstall the OpenWire Client application.

17. The next dialog that appears depends on whether an OpenWire Client machine configuration database already exists in the SQL Server 2005 Express instance you connected to in step 16, and if so, what version of the database exists.
The following scenarios are possible. Perform one of the steps below that is applicable to your installation, then skip to step 18:

a. No configuration database exists - in this scenario, the following screen appears where you can create a new OpenWire Client configuration database.

The default user name is “openwire” and password “Landmark1”. If desired, change the User Name and Password. The credentials are needed for the LGC OpenWire Client service to login to the configuration database. Click Create to install the configuration database.

The System Administrator credentials for “owrfConfigDBR5000” database are not needed for the installation, but are documented for informational purposes only.

- User name: “sa”
- Password: “AStrongPassword”

After the database is created, skip to Step 19 on page 54.
b. OpenWire Client 5000.1.x configuration database exists - in this scenario, the following screen appears where you can replace the existing OpenWire Client configuration database with a new OpenWire Client machine configuration database.

Enter the credentials that the LGC OpenWire Client service will use to login to the configuration database, then click Create. Next, skip to Step 19 on page 54.
c. **OpenWire Client 5000.1.x configuration database exists** - in this scenario, the following screen appears where you can upgrade the existing OpenWire Client configuration database to version 5000.1.4.

All existing configuration data will be moved into the newly upgraded database.

Enter the credentials that the LGC OpenWire Client service will use to login to the configuration database, then click **Upgrade**. When the upgrade is complete, skip to Step 19 on page 54.
d. OpenWire Client 5000.1.4 configuration database exists - in this scenario, the following screen appears where you can create a new 5000.1.4 configuration database or keep the existing OpenWire Client 5000.1.4 configuration database.

Even though you chose to keep the existing configuration database, you have the opportunity to change the user name and password credentials that the LGC OpenWire Client service will use to login to the database. Click **Next**, review and make changes to the credentials if needed, and then click **Finish** to complete the database update process. Next, skip to Step 19 on page 54.
e. OpenWire Client 5000.1.4 configuration database exists - in this scenario, you choose to replace the existing OpenWire Client Software 5000.1.4 configuration database within the SQL Server 2005 Express instance with a new OpenWire Client Software 5000.1.4 configuration database.

Enter the credentials that the LGC OpenWire Client service will use to login to the configuration database, then click Create.
18. After you select the option from the applicable screen that appears, click **OK** to create the user tablespace. When the following confirmation displays, click **OK**.

![Database setup completed successfully](image)

19. Now that the configuration database is either created, upgraded, or replaced, click **Done** to dismiss the dialog, then perform step 20.

20. When all files are copied from the installation, the following screen displays. Click **Finish**.

![InstallShield Wizard Completed](image)

This completes the installation of OpenWire Client machine for SQL Server 2005 and SQL Server 2005 Express.
Installing OpenWire Client Software Configuration Database on Oracle

If you use OpenWire Client software with OpenWorks, then the user must be defined as an external user in each OpenWorks project. This user MUST have Interpreter privileges in OpenWorks.

**Changing the OpenWorks Database Character Set**

The default language set for OpenWorks 5000.0.2.5 database is “AMERICAN_AMERICA.US7ASCII”. If you plan to use special characters, you will need to configure the OpenWorks database character set to the desired setting that is applicable to the language of interest.

For example, if you desire to use a Norwegian character set, you would change the “NLS_LANG” setting found in Windows registry HKLM\SOFTWARE\ORACLE\<ORACLE HOME>\NLS_LANG to “AMERICAN_AMERICA.US7ASCII”.

**Oracle XML Server (XDB)**

If OEM for Oracle (also referred to as MTS) is installed, Oracle will attempt to control the internet port on 8080 by default, which results in a port conflict between Oracle OEM and the OpenWire Client software. This issue appears during the OpenWire Client software login when a dialog displays requesting the “XDB” login. The OEM port assignment is controlled from Oracle's Enterprise Manager under the XML Database Configuration tab, and must be modified (or at least temporarily disabled) to successfully install the OpenWire Client software.
21. Select **Oracle** to store the OpenWire Client software configuration information in a Oracle database, then click **Next**.

![Database Type](image)

22. Click **Install**.

![Ready to Install the Program](image)

A panel displays that shows the progress of the installation.
During the installation of OpenWire Client Software 5000.1.4, if you choose Oracle as the database to install the configuration database onto, you are prompted for an Oracle connection. This connection requires the host name of the machine running Oracle Server, the system identification of the database where you want to install (typically called the SID) and a valid username and password. This user must have the following privileges during the installation process, after which the create privileges may be removed:

- Create Session/Alter Session
- Create/Drop/Alter/Select/Insert/Update/Delete on Tables
- Create/Drop/Alter/Select/Insert/Update/Delete on Views
- Create/Delete on sequence

If Oracle was selected above in step 21 as the destination database, the following screen displays.
23. Enter the **Host** name, **Port** (if different than 1521 default), **Oracle SID**, **User Name**, and **Password**. If this information is not known, contact the Database Administrator.

---

Do not enter the same **User Name** if a previous version of OpenWire Client software was installed on the Oracle database

If you have installed a previous version of OpenWire Client machine on Oracle, and then install a OpenWire Client Software 5000.1.4 configuration database with the same user name, or one that was created in OpenWire Client machine, an error will occur. This is because the constraint names and some table names have changed from previous versions of the database. The error produced from using the same user name may corrupt the existing configuration database and make it no longer usable from previous versions of OpenWire Client machine.

Workaround: enter a user name other than the one used to install previous versions of OpenWire Client machine on Oracle, or any user created by OpenWire Client machine.

If you want to install OpenWire Client machine on Oracle with the same user name, first remove the existing user from Oracle database manually, and then recreate the user with the existing privileges before installing OpenWire Client machine.

---

24. Click **Test Connection** to verify the Oracle connection is satisfactory.

---

![Information dialog box](image)

Once the test is complete and satisfactory, click **OK** to clear the confirmation then **OK** on the Oracle Settings dialog.
25. The next dialog that appears depends on whether an OpenWire configuration database already exists in the Oracle instance you connected to in step 23, and if so, what version of the database exists.

The following scenarios are possible:

a. No configuration database exists - in this scenario, the following screen appears where you can create a new OpenWire Client configuration database.

b. Pre-5000 version configuration database exists - in this scenario, the following screen appears where you can upgrade the pre-5000 version of OpenWire Client’s configuration database to the current 5000.1.4 version.

For example, you may have a 2003.0.8 configuration database that contains settings you wish to preserve. In this case, select the “Selective Upgrade existing OpenWire Client database to 5000.1.4 database” option.
c. OpenWire Client 5000.1.x configuration database exists - in this scenario, the following screen appears where you can replace the existing OpenWire Client 5000.1.x configuration database with a new OpenWire Client 5000.1.4 configuration database.

![Oracle Database install options]

OpenWire Client 5000.1.x configuration database exists. Select an option, and then click OK to proceed:

Select an option
- Create OpenWire Client 5000.1.3 database from scratch.
- Upgrade existing OpenWire Client 5000.1.1 database to OpenWire Client 5000.1.3 database.

Select this option to replace the existing OpenWire Client configuration database with a new one. CAUTION: the existing configuration database is removed and cannot be retrieved.

OK Cancel

d. OpenWire Client 5000.1.x configuration database exists - in this scenario, the following screen appears where you can upgrade the existing OpenWire Client 5000.1.0 configuration database.

All existing configuration data will be moved into the newly upgraded database.

![Oracle Database install options]

OpenWire Client 5000.1.x configuration database exists. Select an option, and then click OK to proceed:

Select an option
- Create OpenWire Client 5000.1.3 database from scratch.
- Upgrade existing OpenWire Client 5000.1.1 database to OpenWire Client 5000.1.3 database.

Select this option to upgrade the existing OpenWire Client 5000.1.1 configuration database. Existing configuration data will be migrated into the new database.

OK Cancel
e. OpenWire Client 5000.1.x configuration database exists - in this scenario, the following screen appears where you can create a new 5000.1.4 configuration database but keep the existing OpenWire Client 5000.1.x configuration database.

After you select the option from the applicable screen that appears, click OK to create the user tablespace. When the following confirmation displays, click OK.
26. When all files are copied from the installation, the following screen displays. Click **Finish**.

![Screenshot of InstallShield Wizard Completed]

This completes the installation of OpenWire Client machine for Oracle.

**Checking the Installation**

To check that the installation completed properly, open Internet Explorer on the OpenWire Client software and type the following:

```
http://ComputerName or IP Address:8080/openwire/index.html?login
```
the OpenWire Client software “User Login” screen displays.

This page has three sections: User Login, Language, and a box where new users can request a login and where existing users can obtain their password.

**User Login**—self-explanatory

**New Users/Forgotten Password**—can obtain a login using two methods: click on the New User link to open a web page and complete the New Users form, or they can contact an OpenWire Administrator directly. If new users complete the New Users form, the request is sent to the OpenWire Administrator via email. For the process to work, an email address for the administrator must exist and a SMTP server address must be designated. See “Requesting a Login ID” on page 76 for more information.

Forgotten passwords are sent to the email account of the registered user.
To run OpenWire Client software, log in using a User Name of **admin** and a password on **admin123** (the User Name and Password are not case sensitive). Then click the Log In button.

If the Server Status page displays with no errors, then OpenWire Client software, Apache Tomcat Server, Microsoft SQL Server, and Java are successfully installed.

Pipelines may exist in the Server Status pane if you updated a 5000.x configuration database during the installation, or you imported pipelines with the Migration Utility (see “Migrating OpenWire Client Software Configuration Settings” on page 20).

### Upgraded Pre-5000 Release Configuration Databases

Pipelines and Database Connections will not appear if you chose the “Selective Upgrade existing OpenWire Client database to 5000.1.4” option during the installation to upgrade a pre-5000 version configuration database.
Repairing the Installation

If you suspect that the installation is corrupt, you can run a repair of the current installation of OpenWire Client machine.

1. To start the OpenWire Client software repair, log in to the Landmark Software Manager web site and navigate to the OpenWire Client software installation directory.

   Click on the Releases tab, and then select OpenWire Client 5000.1.4 and re-run the installation.

   - or -

   From Windows “Add or Remove Programs”, select the “Click here for support information” link shown in “Landmark OpenWire Client Software 5000.1.4”. A “Support Info” dialog displays. Click on Repair button.

   ![Support Info](image)

   The program will run a repair routine. The database update process will run, which you can cancel if you do not desire to recreate the configuration database. Otherwise, no further action is required if you choose this method to repair the program.
If you chose to repair the program by running the installation again, the following Installation Wizard screen displays.

2. Click **Next** to proceed.

3. Select **Repair**, and then click **Next**.

4. Click through the screens of the normal installation process. For more information about the process, see “Installing OpenWire Client Software” on page 18.

    Missing or corrupt files, shortcuts, and registry entries are repaired.
Post-Installation Instructions

Post-installation instructions are provided to help you set up and configure OpenWire Client machine and other programs.

In order for OpenWire Client users to successfully use the program, you MUST perform the Required Tasks applicable to your installation as listed below.

Required Tasks

• Change the default Administrator password (page 68)

• Setup the SMTP Server page 69

• If external connections require a proxy server, setup the Proxy server for the OpenWire Client application (page 70)

• Configure the EDM database to enable SAM functionality for the OpenWire Client application (page 72)

• Configure the OpenWorks database to create Position Logs when trajectory objects are received from OpenWire Client machine pipelines (page 73)

• If you will run pipelines to a GeoFrame database, configure the OpenSpirit and GeoFrame installations (page 75)

Optional Tasks

• Set up OpenWire Client machine users (page 76)

• Set up a simulated provider (page 78)

• Configure Microsoft Internet Explorer running on Windows XP Service Pack 2 (page 80)
Changing the Administrator Password and Setting the Administrator Email Address

Change the Administrator password as soon as possible. When you change the password you should also enter an email address for the Administrator. When new OpenWire Client software users fill in a request for a login, the requests are sent to the email address defined for the Admin.

To set up a new password and define the Administrator email address follow these steps.

1. Launch the OpenWire Client application and log into the program. The “Server Status” page displays.

2. Select Admin Utility > OpenWire Users in the tool bar on the left side of the screen.

3. Click on the “admin” User name, or select the “admin” User name row from the table, and then click the Edit button at the top.

4. Enter the new password in the Password and Confirm Password text boxes.

5. Enter the Admin’s email address. You do not have to enter any other items.

6. Click the OK button to close the dialog.

Note

You can set up multiple users with the same email address. This causes a problem for the Forgot Your Password item on the login screen. For example, you may use your email address for the Administrator, and you may then set yourself up as a user with the same email address. When you use the Forgot Your Password item on the login pane, you are prompted for your email address. the OpenWire Client software will send the password for the Administrator, not your user login. To change your user password, log in as the Administrator, select menu bar item “Admin Utility” Click on “OpenWire Users”, select your user name, and then select the Edit button to open the “Edit User” dialog and make changes to the user account.
### Setting up the SMTP Server

All requests for a New User login entered via the OpenWire Client software log in page are sent to the email address defined in “Changing the Administrator Password” and “Setting the Administrator Email Address” section. If you have other users with Administrator privileges, they can also set up and configure user accounts. For more information on setting up users, please open the Online Help and go to the Table of Contents. Review the “Working with OpenWire Client Users” and “User Roles - Definitions” topics in the Admin Utility book.

To set up the SMTP server:

1. Select **Admin Utility > Server Settings** to open the “Server Settings” dialog.

2. Enter the **SMTP Server Address** in the text box.

3. If your SMTP server requires authentication, activate the checkbox next to **Server Requires Authentication**, and then enter the **Server User** account name and **Server Password**.
Setting up the Proxy Server

OpenWire Client software gives you the option of using a proxy server to provide firewall protection and caching. Network Administrators may implement policies to limit access to the Internet, and to filter the WITSML providers.

To use a proxy server:

1. Sign in to OpenWire Client software as the Administrator.
2. Select Admin Utility > Proxy Settings on the menu bar to open the “Proxy Settings” dialog.
3. Activate the checkbox next to Use HTTP Proxy Server.
4. Enter the Address and Port for the proxy server.
5. If the proxy server requires authentication, activate the checkbox next to Proxy Requires Authentication.
6. Enter the User Name and Password (enabled if the proxy requires authentication checkbox is activated).
7. Click OK to save the information and follow the prompt to restart the LGC OpenWire Client and LGC OpenWire Client Database services.

Note

Any change to the proxy server requires a restart of the LGC OpenWire Client and LGC OpenWire Client Database services.
Running Proxy and Non-Proxy Connections

In some scenarios, a company may desire to access both internal and external WITSML provider connections using the same OpenWire Client service. In this case, internal WITSML providers reference servers that exist behind the company firewall while external WITSML providers exist outside the company firewall and are accessed via a HTTP proxy server. Such a scenario is shown in a simplified representation below.

OpenWire Client software supports simultaneous connections to proxy and non-proxy provider connections with a minor modification to two files located on the OpenWire Client machine.

To configure the OpenWire Client application to support both proxy and non-proxy connections, the Administrator must perform the following:

1. Set up the Proxy Server for external provider connections in the Administrator Utility.

2. To setup a list of internal servers for which OpenWire Client software will bypass the proxy settings, navigate to \OpenWire-5000.1.4.0\conf and open “wrapper.conf” with MS Wordpad.
3. Search for the section titled “# Java Additional Parameters”, and then add the following line after the last line of the section (this line is before the section titled “# Initial Java Heap Size (in MB)”) 

```
wrapper.java.additional.3=-Dhttp.nonProxyHosts=IPAddress1,IPAddress2,IPAddress3
```

where “IPAddress1,IPAddress2,IPAddress3” are the IP addresses of three hosts which the OpenWire Client application would connect to without using a HTTP proxy. If only one non-proxy host connection is needed, specify only one host IP address on the respective line. The example line shown above demonstrates that you can provide multiple host IP addresses separated by commas. DO NOT add spaces after the commas. There is no limit to the number of hosts.

4. Navigate to `\OpenWire-5000.1.4.0\apache-tomcat-6.0.26\conf` and open “wrapper.conf” with MS Wordpad.

5. Perform step 3 again on this copy of “wrapper.conf”, but insert the following line:

```
wrapper.java.additional.7=-Dhttp.nonProxyHosts=IPAddress1,IPAddress2,IPAddress3
```

6. Restart LGC OpenWire Client and LGC OpenWire Client Database services.

**Setting up EDM for the SAM to Work in a Network Environment**

Some Engineer’s Desktop Users install all the programs on their individual computer. OpenWire Client software users are in a Client/Server environment. It may be necessary to change a setting in EDM to have the Simultaneous Activity Monitor (SAM) work correctly with OpenWire Client software; please refer to EDM Administration Guide for more detailed help on SAM.

The steps to configure SAM to work with OpenWire Client software are as follows:

1. From the **Start** button select **All Program > Landmark Engineer’s Desktop > Tools > EDM Administration**.

2. Select the appropriate EDM database and enter the proper authentication.

3. Click on **Simultaneous Activity Monitor (SAM)**.
4. If the Hostname or IP address has localhost listed, you will need to change it by entering either the server name or the server IP address.

5. Once you have entered the information, close the window.

**Configure the OpenWorks Database to Create Position Logs**

In order for OpenWorks pipelines to operate correctly, you must point to a valid OpenWorks database SID. Landmark recommends that you configure the OpenWorks database before you allow users to login to the OpenWire Client application.

There is a known issue related to creating Position Logs in the OpenWorks database. When the aziRef element is defined as “True North” in the OpenWire Client application, an error is reported in the pipeline log that states “null Cannot read data from database” even though the Read/Build/Write status shows green.

To prevent this problem from occurring when users create pipelines that contain trajectory objects to OpenWorks databases, perform the following:

1. Open the Project Status tool in OpenWorks Administration.

2. Select the District.

   The District must exist and reference the valid OpenWorks database SID in the “district.dat” file located in \conf directory where OpenWorks Client or OpenWorks Server is installed.

3. Select a valid OpenWorks SID

   A valid OpenWorks database SID is defined as one that contains a user account with at least Interpreter rights AND also has “Log on as a service” rights granted on the OpenWire Client machine.

   The SID must also exist in “tnsnames.ora”.

4. Select the OpenWorks project.

   Only District, SID, and Project must be selected in order to properly create OpenWire Client pipelines. Specify the remaining parameters if they are known, but they are optional.
Changing the OpenWorks Database Character Set

The default language set for OpenWorks 5000.0.2.5 database is “AMERICAN_AMERICA.US7ASCII”. If you plan to use special characters, you will need to configure the OpenWorks database character set to the desired setting that is applicable to the language of interest.

For example, if you desire to use a Norwegian character set, you would change the “NLS_LANG” setting found in Windows registry HKLM\SOFTWARE\ORACLE\<ORACLE HOME>\NLS_LANG to “AMERICAN_AMERICA.US7ASCII”.

**Configuring OpenSpirit/GeoFrame Installations**

Before you can add GeoFrame database connections, you must meet some prerequisites, and then define settings in OpenWire Client machine.

**Prerequisites to Adding a GeoFrame Connection**

In order to run OpenWire Client machine pipelines to a GeoFrame database, the following prerequisites MUST be satisfied:

- A GeoFrame database must exist and be network accessible to the OpenWire Client software. Landmark recommends installing the GeoFrame database on a Linux platform.

- OpenSpirit Master 3.1.2 (SP1) must be installed on the same machine as the GeoFrame database. OpenWire Client machine supports only connections to a GeoFrame 4.3 database using OpenSpirit 3.1.2 (SP1).

- The default settings for the transfer of data to a GeoFrame 4.3 database must be defined in the GeoFrame Settings dialog.

- OpenSpirit Satellite must be installed on the same machine as OpenWire Client machine.

**Important!**

You must install OpenSpirit Satellite with an account that has Administrator rights to the machine, but DO NOT use the local machine “Administrator” account.

**Defining GeoFrame Settings**

In previous versions of OpenWire Client machine, GeoFrame database connection settings are defined through the “GeoFrame Settings” dialog. Starting in version 5000.1.1, all GeoFrame database connection settings are read from the OpenSpirit connection, and no longer configured by the OpenWire Client Administrator.

In order for OpenWire Client machine to read the settings, all prerequisites listed above must be met.
**Requesting a Login ID**

If a user needs a login ID they can request one from the User Login pane or they can contact an OpenWire Client Administrator. When the user clicks on the OpenWire Client machine URL, the following window displays.

![User Login Window](image)
The new user can click on the link next to New User which will take them to the New User Registration window.

### New User Registration

Enter your registration information below. Once you submit your personal information, the OpenWire administrator will be notified to add you as a user of OpenWire. Upon activation, an email will be sent to you confirming your registration and giving you authorization to use the application.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name*</td>
<td></td>
</tr>
<tr>
<td>Middle Initial</td>
<td></td>
</tr>
<tr>
<td>Last Name*</td>
<td></td>
</tr>
<tr>
<td>User Name*</td>
<td></td>
</tr>
<tr>
<td>Password*</td>
<td></td>
</tr>
<tr>
<td>Confirm Password*</td>
<td></td>
</tr>
<tr>
<td>Email Address*</td>
<td></td>
</tr>
<tr>
<td>Contact Phone</td>
<td></td>
</tr>
<tr>
<td>Mobile Phone</td>
<td></td>
</tr>
</tbody>
</table>

The mandatory fields are marked with '*' sign.

Fill in this form as needed. To request multiple accounts, click **Reset** to clear the form, and then enter additional user information until finished. All items with an asterisk are mandatory and the User Name can contain only alpha-numeric characters. When finished, click **Submit** and then **Back**.

After a user clicks **Submit**, OpenWire Client machine places the new request in the Admin Utility > New User Requests pane. Administrators can refer to the online help for more information about how to create and manager OpenWire Client machine user accounts.

After the Administrator creates the new account, the user receives a notification by email that the account now exists. The email also includes a link to the OpenWire Client machine log in screen.
Setting up the Simulator

When you install OpenWire Client machine, the Installation Wizard installs simulated WITSML data on the OpenWire Client software. This data can be used to test the movement of data into your destination database. Setting up the simulated provider is exactly the same as setting up a WITSML provider. To set up the simulated data as a provider:

1. Launch OpenWire Client machine and log in to the application.
2. Click Provider Connections on the left panel.
3. When the “Provider Connections” pane displays, select All Provider Connections and then click the New button.
4. Enter a Name for the connection. The Description is optional.
5. The URL for the simulated data which is shown below is case sensitive.
   
   http://<ComputerName or IP address>:8080/openwireSimulator/services/witsmlSim120

   Note: The URL for the local machine displays at the bottom of the New Provider Configuration screen, which can be copied and pasted into the URL field.
   
   Remember to enter the port number that applies to your installation!
6. To test the connection, click the Test Connection button. You should receive a message that the connection succeeded. If the connection did not succeed, please look at your entries to ensure they are correct.
7. Click the Save button. When you return to the Provider Connection pane, the name you entered for the simulated data provider connection is in the table.

Once a provider connection is defined, you can set up a Destination Database and Pipeline to move the test data to a test well in your destination database. The instructions for both are in OpenWire Client Help.
Simulated Drilling

You can modify the simulated data to allow the simulator to load the trajectory and log objects in multiple passes (as if you were drilling) rather than all in one shot.

1. Navigate to the /OpenWire-5000.1.4.0/webapps/OpenWireSimulator/config directory.

2. Edit the simulator.config file (for the applicable WITSML version) to enter depths that OpenWire Client machine should load in each subsequent session.

3. Delete the simulator.state file (for the applicable WITSML version) since OpenWire Client machine stores the last pass's depth in this file.

4. Run a pipeline using the simulator as the Provider.
Changing Microsoft Internet Explorer Setting for OpenWire Client Software on Windows XP, SP 2 and SP3

You can skip this section if you are not using Windows XP Service Pack 2 or Service Pack 3 for the OpenWire Client software or client computer.

Windows XP Service Pack 2 added several security enhancements. These security enhancements will affect the online help and some of the pipeline screens. Listed below are changes that need to be made on the client and server computers in order to view the online help.

The instructions below will turn off the popup blocker and some of the Active X settings.

1. Launch Internet Explorer.
2. Select Tools > Internet Options.
3. Select the Advanced tab.
4. Scroll down to the last heading called Security.
5. Place a check next to the item Allow active content to run in files on My Computer.
6. Click Apply.
7. Select the Security tab.
8. Click the Custom level button.
9. Go to the Miscellaneous > Use Pop-up Blocker item.
10. Place a check mark next to Disable.
11. Click Apply then OK to save your setting and close the panel.
Troubleshooting

The following problems may occur during or after the installation.

- Errors are received when you attempt to install the configuration database into a SQL 2005 or 2008 instance (see “Installing OpenWire Client Configuration Database in a non-EDM SQL Server 2005 Express and SQL Server 2008 Express Instance” on page 82).

- If you receive error messages during the installation, or you can log into OpenWire Client software, but see the following error message, then the LGC OpenWire Client and/or LGC OpenWire Client Database services did not start.

  Connection refused to host:localhost: nested exception is: javj.net: ConnecttException:
  Connection refused: connect

  For more information, see “Services Do Not Start” on page 86.

- You cannot log into OpenWire Client machine. There are several problems that may stop you from seeing the OpenWire Client machine login page.

  — Services not installed (see “Services Do Not Install” on page 89).
  
  — Interrupted installation causes Windows registry problems (see “Problems With Interrupting the Installation” on page 92).
  
  — Apache Tomcat server conflicts with another application that uses the default 8080 port (see “The Apache Tomcat Server Has a Port Conflict” on page 94).
  
  — Licensing problems (see “Receiving an Error Message After Login” on page 94).
  
  — Invalid Windows Security Certificate (see “Invalid Windows Security Certificates” on page 96).

- You start an application for the first time under Windows 7 and it is unable to create wallet information (see “Unable to Create Wallet Information” on page 98).
Installing OpenWire Client Configuration Database in a non-EDM SQL Server 2005 Express and SQL Server 2008 Express Instance

You may experience problems when installing OpenWire Client machine’s configuration database in a non-EDM SQL Server or SQL Server Express instance. The following procedure can be used to troubleshoot problems associated with installing the configuration database into a standalone SQL Server 2005 Express instance. The procedure for troubleshooting SQL Server 2005 and SQL Server 2008 Express is similar and will not be covered.

Option A: Check the SQL Express Installation

1. Launch SQL Server 2005 Configuration Manager and verify the “SQL Server Browser” is “Stopped”.

2. If not, stop and perform “Option B: Reinstall SQL Express” on page 85 now.

3. If the “SQL Server Browser” is stopped, then open the Windows Services panel and perform the following

   a. Set the “SQL Server Browser” service Startup Type to **Automatic**. In the “Log On” tab, the account information should be :NT Authority\NetworkService. DO NOT change the account information.

   b. Start the ‘SQL Server Browser’ service.
4. In SQL Server Configuration Manager, press F5 to refresh the view. The “SQL Server Browser Service” should now display as “Running”.

5. Select “SQL Server 2005 Network Configuration”. Right-click on the protocols and enable each one.


7. Run the “setupSqlExpressDatabase.bat” file from \OpenWire-5000.1.4.0\setup directory.

8. Enter your password and click Next. This assumes the SQL instance was configured during installation in “Mixed Mode”
authentication. Mixed Mode allows you to specify a password during the SQL installation process, and that is the password to enter in this step.

9. Click **Next**.

10. When the OpenWire Client machine installation asks you to create a new configuration database, enter user name as “openwire” and provide a strong password again, for example “OpenWire123” or just use the default one that the tool has displayed.

    Landmark recommends using the default user name and password for the configuration database to minimize the potential of forgotten credentials for any future installation operations.

11. Click **Create** and the installation will create a configuration database within the SQL instance.

12. Click **Done**.

13. Restart the LGC OpenWire Client and LGC OpenWire Client Database services.

14. Launch the OpenWire Client application and log in with user name “admin” and password “admin123”. 
**Option B: Reinstall SQL Express**

1. Shutdown the LGC OpenWire Client and LGC OpenWire Client Database services.

2. Uninstall all SQL Server 2005 SP2 components (including MS SQL Native Client) from Windows Add/Remove Programs

3. Open Notepad and enter the following line:

   ```
   start /wait .\SQLEXPR32.EXE /q ADDLOCAL=All INSTANCENAME=IKHIDE DISABLENETWORKPROTOCOLS=0 SAPWD=Ikhide123 SECURITYMODE=SQL
   ```

4. Substitute the INSTANCENAME with your preferred name.

5. Substitute the SA password with your preferred STRONG PASSWORD

   **Strong password rules:**
   
   • the password must be greater than 8 characters  
   • at least one character must be from 3 out of 4 of the following:  
     • lower case characters  
     • upper case characters  
     • numeric  
     • special characters (non-alphanumeric)

6. From Notepad, save the file as a batch file (e.g., “openwire.bat”) to the directory where you downloaded the SQL Server Express 2005 setup executable (SQLEXPR32.exe).

7. Run the batch file you created in the previous step.

8. Once the install completes, run the “setupSqlExpressDatabase.bat” file from the ‘\OpenWire-5000.1.4.0\setup directory.

9. Change the “Instance Name” to the one specified in the batch file.

10. Enter the “Password” to the one specified in the batch file.

11. Click **Next**.

12. When the installation asks you to create a new configuration database, enter user name as openwire and provide a strong password again. For example, “OpenWire123” or use the default
one that the tool has displayed (Landmark recommends using the default to minimize the potential of forgotten credentials for any future installation operations).

13. Click **Create** and the installation will create a configuration database.

14. Click **Done**.

15. Restart the LGC OpenWire Client and LGC OpenWire Client Database services.

16. Launch the OpenWire Client application and log in with user name “admin” and password “admin123”.

**Services Do Not Start**

You may receive an error message similar to the one below when you install OpenWire Client software.

![Information](image)

This error message indicates that the Windows services for OpenWire Client software and/or Apache Tomcat server did not automatically start. There are three reasons for this.

- the OpenWire Client software license could not be found
- the User Name and Password combination you entered during the Installation process does not have the necessary permissions to start the services
- the user name under which services start needs to be changed

**Solution 1: Check the license**

To check the license file location, go to your environment variables to see where the LAM license file is located. Check the license file for a line that begins with:

```
OPENWIRE_SERVER licsrv 5000...
```

and a line that begins with one of the following.
If you are missing lines in the license file needed to run OpenWire Client software and create database specific pipelines, please contact Landmark to obtain the required OpenWire Client software and pipeline licenses.

**Solution 2: Start services manually**

The User Name and Password combination you entered during the Installation process does not have the necessary permissions to start the services.

The solution to this problem is to start your services manually. The steps below are for a Windows XP operating system. If you use Windows 2003 Server, the steps may differ slightly.

1. Select **Start > Control Panel**.

2. If you are in the Classic View, select **Administrative Tools > Component Services > Services (Local)**.

3. If you are in Category View, select **Performance and Maintenance > Administrative Tools > Component Services > Services (Local)**.

4. Highlight **LGC OpenWire Client** on the right panel. Verify the service is running. If the service is not running, proceed to step 5. If the LGC OpenWire Client service is running, proceed to step 6.

5. Click on **Start** the service or select **Action > Start** from the menu bar. Go to step 7 if the service did not start.

6. Highlight **LGC OpenWire Client** on the right panel. Verify the service is running. If the service is not running, proceed to step 7. If the LGC OpenWire Client service is running, proceed to step 8.

7. **Start** the LGC OpenWire Client service. If the service starts correctly, then you have finished starting the services. If the service did not start, proceed to step 8.

8. Close the Component Services screen and the Control Panel.
9. If you received the following message when starting the service, a conflict exists between the password that Component Services expects and the password you are using.

![Error message]

10. Open Component Services and click on **LGC OpenWire Client**.

11. Right click and select **Properties**.

12. Click on the **Log On** tab.

13. Enter your password in the **Password** and **Confirm password** boxes.

14. Go back to step 4 and start the service.

15. If the service(s) will not start after attempting a restart and checking the service passwords, check the **Log on as a service** local security policy as described next.

16. Select Windows **Start > Control Panel > Administrative Tools > Local Security Policy**

17. Expand the Local Policies folder and click on **User Rights Assignment**.

18. From the right panel, double-click on the **Log on as a service** policy.

19. Click on the **Add User or Group** button.

20. Enter the **object name** for the user account you entered during the OpenWire Client software installation.

21. Click **OK** until you are returned to the Local Security Settings dialog, then close it and also close the Administrative Tools dialog.

22. If the service will not start, contact Landmark Support.
Solution 3: Change user name and password in wrapper

The OpenWire Client software starts services using a Java wrapper. The wrapper contains a range of settings, including the user name and password credentials under which the service will run. If the services do not start when installing OpenWire Client on a machine with a previous version, the services may need to be stopped and the wrapper changed.

To change wrapper values:

1. Stop the OpenWire services if they are running.

2. Start Notepad and open the file:
   `<OpenWire install directory>/conf/wrapper.conf`

3. Locate and edit the following lines:
   - `wrapper.ntservice.account=username`
   - `wrapper.ntservice.password=xxxx`

4. Save the wrapper.conf file.

5. Repeat the changes in the file:
   `<OpenWire install directory>/apache-tomcat-6.0.26/conf/wrapper.conf`

6. Restart the OpenWire services.

Services Do Not Install

When OpenWire Client software is installed, references to batch scripts are placed in the `\HKEY_LOCAL_MACHINE\SOFTWARE\MicroSoft\Windows\CurrentVersion\RunOnce` directory of the machine's registry. These batch scripts create the configuration database, LGC OpenWire Client service, and the LGC OpenWire Client Database service. Any scripts referenced in the RunOnce directory are executed the next time the machine is restarted and only this one time.

The batch files are designed to be executed in a particular order when the user reboots the machine after the OpenWire Client machine installation.
PROBLEM

In most cases, the LGC OpenWire Client and LGC OpenWire Client Database services install without issue. Occasionally, one or both services are not created during the OpenWire Client machine installation.

This problem appears to be more prevalent on Windows 2003 and 2008 Server machines.

SOLUTION

The work around presented below assumes OpenWire Client machine is installed that includes successful creation of the configuration database, but missing service(s) are discovered after machine reboot.

For the purpose of this work around, a standard installation is assumed with the default installation directory locations. If your installation directory is different, adjust the procedure to reflect the correct installation path.

1. Determine which service(s) are not installed.

   a. From the Windows Start menu, select Start > Settings > Control Panel > Administrative Tools > Services.

   b. Verify the existence of the LGC OpenWire Client and LGC OpenWire Client Database services.

   c. If one or more of the services are missing, follow the instructions below.

2. Create the LGC OpenWire Client service (if missing).

   a. Navigate to the OpenWire-5000.1.4.0\apache-tomcat-6.0.26\conf directory.

   b. Copy the wrapper.conf file to wrapper.conf2

   c. Open the wrapper.conf file for editing.

   d. Set the line that begins 'wrapper.ntservice.account' equal to the account name that will run the services. For a network
account, include the domain name. For a local account, include the machine name. For example:

```
wrapper.ntservice.account=MYDOMAIN\owire_user
```

e. Set the line that begins “wrapper.ntservice.password” equal to the password for the account that will run the services. For example:

```
wrapper.ntservice.password=mypassword
```

f. Save the changes and exit the editor.

g. Navigate to OpenWire-5000.1.4.0\apache-tomcat-6.0.26\bin and execute the “InstallTomcatWatcherService.bat” file.

h. Check to make sure the services installed and can be started. If the service exists but will not start due to a login failure, double-click on the service name in the “Services” dialog and select the Log On tab. Retype the password for the account and retest the start.

i. Navigate back to the OpenWire-5000.1.4.0\apache-tomcat-6.0.26\conf directory and replace the “wrapper.conf” file with “wrapper.conf2”. This will remove any explicit reference to user names or passwords on the system.

3. Create the LGC OpenWire Client Database service (if missing).

a. Navigate to the OpenWire-5000.1.4.0\apache-tomcat-6.0.26\conf directory.

b. Copy the wrapper.conf file to wrapper.conf2

c. Open the wrapper.conf file for editing.

d. Set the line that begins 'wrapper.ntservice.account' equal to the account name that will run the services. For a network account be sure to include the domain name. For a local account be sure to include the machine name. For example:

```
wrapper.ntservice.account=MYDOMAIN\owire_user
```
e. Set the line that begins 'wrapper.ntservice.password' equal to the password for the account that will run the services. For example:

   wrapper.ntservice.password=mypassword

f. Save the changes and exit the editor.

g. Navigate to the \OpenWire-5000.1.4.0\apache-tomcat-6.0.26\bin directory and execute the InstallOpenWireService.bat file.

h. Check to make sure the services installed and can be started. If the service exists but will not start due to a login failure, double-click on the service name in the “Services” dialog and select the Log On tab. Retype the password for the account and retest the start.

i. Navigate back to the \OpenWire-5000.1.4.0\apache-tomcat-6.0.26\conf directory and replace the wrapper.conf file with wrapper.conf2. This will remove any explicit reference to user names or passwords on the system.

### Problems With Interrupting the Installation

If the installation was interrupted, you will not be able to log into OpenWire Client machine. The problem will usually be caused by a power failure during installation or rebooting a Windows 2003 or 2008 Server when a popup window occurs prior to the Installation Wizard finishing.

#### Windows Automatic Updates

Landmark recommends disabling the Windows Automatic Updates feature if it is enabled prior to installing OpenWire Client machine. This reduces the possibility of receiving an error during the installation. After installation, Automatic Updates can be turned back on if needed. See [Microsoft Help](https://support.microsoft.com) for details on how to disable and enable Windows Automatic Updates.

To correct the problem you will have to delete the installation key in the registry, and the Install Shield installation information in Program Files.
1. From the Windows Start menu, select Start > Run, then type regedit and click the OK button.

2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE > Microsoft > Windows >CurrentVersion >Uninstall.

3. Search for the following application ID.

   \{27F56F82-424A-42DE-B3C8-2B542EA1A6A6\}

4. When you click on the ID, which is on the left side of the dialog box, the DisplayName, on the right side of the dialog, should say “Landmark OpenWire Client Software 5000.1.4”.

5. If you cannot find the ID listed in step 3, you will need to click on each of the IDs and look at the DisplayName for each. When “Landmark OpenWire Client Software 5000.1.4” appears as the DisplayName, write down the ID.

6. To remove the ID, right-click on the ID then select Delete.

7. Close the Registry window.

8. Open Windows Explorer.

9. Navigate to C:\Program Files\InstallShield Installation Information. If you can see files in the directory, go to step 11. If you cannot see files, go to step 10.

10. To see the files in this directory you will need to unhide them. Select Tools > Options from the menu bar then click on the View tab. Select the radio button that says Show hidden files and folders, then click the OK button.

11. Look for the ID number in Step 3 or the ID number you wrote down in step 3.

12. Right-click on the ID, then select Delete.

Depending on where the installation was interrupted, you may have to perform the following step:

13. While in Windows Explorer go to the <installation directory>\OpenWire-5000.1.4.0 subdirectory. If the directory is present, right click on it, then select Delete.
14. You will now need to reinstall OpenWire Client software. Make sure the Installation Wizard finishes before rebooting the computer.

**The Apache Tomcat Server Has a Port Conflict**

If the OpenWire Client application “User Login” pane does not appear, there may be a conflict with the Apache Tomcat Server port number. The default installation is configured to install OpenWire Client machine on port 8080. You can choose another port during the installation.

If the port you chose during installation is used by another application, you will not be able to start the LGC OpenWire Client service. Follow the instructions below to change the port number.

1. Open Notepad or Wordpad then open `<installation directory>\OpenWire-5000.1.4.0\apache-tomcat-6.0.26\conf\server.xml`

   If you defined a different installation location you will need to adjust the path accordingly.

2. Find the line that starts with:

   `<Connector port="8080"`

3. Change port 8080 to another available port.

4. Save and Close the file.

5. Start the LGC OpenWire Client, then Restart the LGC OpenWire Client Database service. See “Services Do Not Start” on page 86 for details.

6. Change the OpenWire Client machine URL to reflect the new port number.

**Receiving an Error Message After Login**

You may receive a message with the following title after logging into OpenWire Client machine.

```
Error: Unable to get OpenWire server status on host <OpenWire installation machine Name>.
```
This error message indicates a problem with the license server. A text message in this error box explains how to correct the problem. Instructions are also listed below.

To correct this problem:

1. Verify that the license file contains the license feature beginning with the name OPENWIRE_SERVER.

2. Verify that the license server is running and licenses are available.

3. Once the license server is running properly, restart the LGC OpenWire Client service.

4. Verify the LAM Client on the OpenWire Client machine (or LAM Server if you are pointing to a license server) is configured to ignore the License file path environment variable. To do so, open lmtools on the client machine, and then select the “Server/License File” tab. On the tab, make sure the “LMTOOLS ignores License file path environment Variable” is UNCHECKED.

5. Restart the LGC OpenWire Client service.

For instructions on starting the services, see page 86.

**License Variables**

- When using an environment variable to point to multiple LAM servers on different machines, as would be the case where you desire to run OpenWire Client 2003 and 5000 versions on the same machine, make sure that the 2003 LAM server is listed first.

- Use the LAM Server host machine IP address in the variable (e.g., “2013@LAM Server Host IP Address”).
Invalid Windows Security Certificates

Certificates are used with the HTTPS protocol to authenticate Web clients. In the case where OpenWire Client machine encounters a site java certificate as untrusted, due to some inconsistency in the certificate, it is necessary to add the site certificate to OpenWire Client Software 5000.1.4 Client's java certificate store (“cacerts” file) manually.

In cases where you desire to access more than one secure provider, you must use the “-alias” option (see step 13 in the procedure below).

PROBLEM

An invalid certificate results in an error similar to the following when attempting to connect to the Provider.

*******************************************************
Connection to the provider failed.
; nested exception is: javax.net.ssl.SSLHandshakeException:
sun.security.validator.ValidatorException: PKIX path building failed:
sun.security.provider.certpath.SunCertPathBuilderException: unable to find valid certification path to requested target
Connection Name: Aberdeen_SLB
Description:
URL: https://europe.interact.com/Publishing/WITSMLAPI120.asp
*******************************************************

SOLUTION

The following procedure replaces the existing “cacerts” file on the OpenWire Client software, assuming a standard installation, and overwrites any previously added security certificates. This should not be a problem with trusted sites since they will be automatically added back in when encountered. However, any untrusted sites previously added manually will be lost and must be added again.

1. Shutdown both the LGC OpenWire Client and LGC OpenWire Client Database services.

2. Create a directory on the file system to store the cert files. For example purposes this directory will be named C:\certs

3. Navigate to C:\<installation directory>\OpenWire-5000.1.4.0\JDK1.6.0\jre\lib\security and move the existing “cacerts” file to the C:\certs directory as “orig_cacerts”.
4. Open a browser and navigate to the URL for the provider connection. For example:

   https://europe.interact.slb.com/Publishing/WITSMLAPI120.asp

5. When the Security Alert window appears click the View Certificate button

6. When the Certificate window appears select the Details tab

7. Click the Copy to File button and proceed through the Certificate Export Wizard accepting all defaults.

8. On the “Export File Format” screen, select the Base-64 encoded X.509 (.CER) option.

9. When prompted for a file name direct the file to C:\certs and use a .cer extension. Example: interact_europe.cer

   A message appears when the export is complete.

10. Close the certificate dialogs and exit the browser.

11. Open a DOS window and navigate to the C:\certs directory.

12. Add the location of the keytool executable to the path using the following command.

        set path=C:\Landmark\OpenWire-5000.1.4.0\JDK1.6.0\bin;%path%

13. Run the keytool utility specifying the .cer file exported from the provider site, an internal alias name, and a new “cacerts” file name. Using the examples above the command would be:

        keytool -import -alias slb_europe -file interact_europe.cer -keystore interact_europe_cacerts

14. When prompted, enter a password. Since this is a new file you will specify a new password.
15. When prompted, enter **Yes** and press the **Return** key to indicate the certificate is trusted.

**Important!**

It is important to specify the -alias option in the keytool command in step 13 above in order to connect to more than one SSL provider at a time. This is how individual certificates are identified within the cacerts file. It is also important to make sure the alias name for each certificate is unique, otherwise subsequent imports will overwrite.

16. Navigate to C:\certs directory and copy the newly create certificate cache file to C:\<installation directory>\OpenWire-5000.1.4.0\JDK1.6.0\jre\lib\security as “cacerts” replacing the original that had been moved earlier.

17. Using the examples above the C:\certs\interact_europe_cacerts file would be copied as C:\<installation directory>\OpenWire-5000.1.4.0\JDK1.6.0\jre\lib\security and renamed to “cacerts”.

18. Restart the OpenWire Client services and test the provider connection.

**Unable to Create Wallet Information**

When an application (for example, Project Status Tool) is started for the first time, it creates a folder structure containing user information. In Windows 7, the application is blocked from creating wallet information.

To correct this problem:

1. Log on to a machine on which OpenWorks is installed but that is running a version of Windows other than Windows 7.

2. Open Windows Explorer and navigate to the folder:
   C:\<installation directory>\OpenWorks\users\your username

3. Copy the folder:
   wallet

4. Using any file transfer mechanism, move the copy of wallet to your Windows 7 machine.
5. **Paste the wallet folder into:**

   \( C:\installation\ directory\OpenWorks\users\your\ user\ name\)